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Design Intent, Sketching and Sketch Entities

CHAPTER 4: DESIGN INTENT,
SKETCHING AND SKETCH
ENTITIES

Chapter Objective

Chapter 4 provides a comprehensive understanding of Design Intent, Sketching and the
available Sketch Entities in SolidWorks. On the completion of this chapter, you will be
able to:

e Define and incorporate Design Intent in a:
e Sketch, Feature, Part, Assembly and Drawing
e Utilize the available SolidWorks Design Intent tools:

e Comments, Design Binder, ConfigurationManager, dimensions, equations, design
tables and features

e Identify the correct Reference planes:
e 2D Sketching
e 3D Sketching
e Insert sketch Reference planes
e Comprehend the Parent/Child relationship
e Recognize and address Sketch states:

e Fully Defined, Over Defined, Under Defined, No Solution Found and Invalid
Solution Found

e Identify and utilize the following Sketch Entities tools:

e Line, Corner Rectangle, Center Rectangle, 3 Point Corner Rectangle,
3 Point Center Rectangle, Parallelogram, Straight Slot, Centerpoint Straight Slot,
3 Point Arc Slot, Centerpoint Arc Slot, Instant3D, Polygon, Circle, Perimeter
Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Spline, Spline on Surface, Equation Driven Curve, Point, Centerline,
Text, Plane, Route line and Belt/Chain

e (lassify and utilize the following Block tools:

e Make Block, Edit Block, Insert Block, Add/Remove, Rebuild, Saves Block,
Explode Block and Belt/Chain

e Recognize and utilize the following Spline tools:
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Design Intent, Sketching and Sketch Entities

e Add Tangency Control, Add Curvature Control, Insert Spline Point, Simplify
Spline, Fit Spline, Show Spline Handle, Show Inflection points, Show Minimum

Radius and Show Curvature Combs

Design Intent

What is design intent? All designs are created for a purpose. Design intent is the
intellectual arrangements of features and dimensions of a design. Design intent governs
the relationship between sketches in a feature, features in a part and parts in an assembly.

The SolidWorks definition of design intent is the process in which the model is
developed to accept future modifications. Models behave differently when design

changes occur.

Design for change! Utilize geometry for symmetry, reuse common features, and reuse
common parts. Build change into the following areas that you create: sketch, feature,

part, assembly & drawing.

w1

“¥* When editing or repairing geometric relations, it is considered best practice to edit

the relation vs. deleting it.

Design Intent in a sketch

Build design intent in a sketch as the profile is
created. A profile is determined from the
Sketch Entities. Example: Rectangle, Circle,
Arc, Point, Slot etc. Apply symmetry into a
profile through a sketch centerline, mirror
entity and position about the reference planes
and Origin.

Build design intent as you sketch with
automatic Geometric relations. Document the
decisions made during the up-front design
process. This is very valuable when you
modify the design later.

A rectangle (Center Rectangle Sketch tool)
contains Horizontal, Vertical and
Perpendicular automatic Geometric relations.

Apply design intent using added Geometric
relations if needed. Example: Horizontal,
Vertical, Collinear, Perpendicular, Parallel,
Equal etc.
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Design Intent, Sketching and Sketch Entities

Example A: Apply design intent to create a square profile.

Sketch a rectangle. Apply the Center Rectangle Sketch tool. = 1.50 —
Note: No construction reference centerline or Midpoint
relation is required with the Center Rectangle tool. Insert . i o
dimensions to fully define the sketch. 120 |m 3

Example B: Develop a rectangular profile. Apply the e = ™,
Corner Rectangle Sketch tool. The bottom horizontal
midpoint of the rectangular profile is located at the
Origin. Add a Midpoint relation between the horizontal
edge of the rectangle and the Origin. Insert two
dimensions to fully define the rectangle as illustrated.

1
200 |n [
l

Design intent in a feature

Build design intent into a feature by addressing
symmetry, feature selection, and the order of feature
creation.

Example A: The Extruded Base feature remains
symmetric about the Front Plane. Utilize the Mid Plane
End Condition option in Direction 1. Modify the depth,
and the feature remains symmetric about the

Front Plane.

Example B: Create 34 teeth in the model. Do
you create each tooth separate using the
Extruded Cut feature? No.

Create a single tooth and then apply the
Circular Pattern feature. Modify the Circular
Pattern from 32 to 24 teeth.

Design intent in a part

Utilize symmetry, feature order and reusing
common features to build design intent into a part.
Example A: Feature order. Is the entire part
symmetric? Feature order affects the part.

Apply the Shell feature before the Fillet feature and
the inside corners remain perpendicular.
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Design intent in an assembly

Utilizing symmetry, reusing common parts and using
the Mate relation between parts builds the design
intent into an assembly.

Example A: Reuse geometry in an assembly. The /T
assembly contains a linear pattern of holes. Insert one /
screw into the first hole. Utilize the Component Pattern
feature to copy the machine screw to the other holes.

Design intent in a drawing

Utilize dimensions, tolerance and notes in parts
and assemblies to build the design intent into a
drawing.

Example A: Tolerance and material in the T
drawing. Insert an outside diameter tolerance
+.000/-.002 into the Pipe part. The tolerance
propagates to the drawing.

Define the Custom Property Material in the Part.
The Material Custom Property propagates to your
drawing.

Fipe - Custorner ABC

AT00aa

w1

‘¥* Create a sketch on any of the default planes:
Front, Top, Right or a created plane.

SolidWorks Design Intent tools

Comments

Add comments, notes or additional information to features during the design period. This
will aid you or your colleagues to recall and to better understand the fundamental design
intent later of the model and individual features.
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Right-click on the FeatureManager name. Click
Comment > Add Comment from the

Comrment

Parent/Child. ..

% » AJ Add Comment:

FeatureManager design tree. The Comment dialog Iogh
box is displayed. Enter the information. Move your
mouse pointer over the feature. The created Exirtide2

|
Extrudel
Caomment:
Created For Customer Y2

comment is shown in a balloon format.

052002008 09:57 AM mplanchard:
1

w1
- Cormment

“¥" You can also add a Date/Time stamp to your

Earer&hild. -

-

.S.J Edit Comment:

Delete Comment:

comment.

& Design Binder

Design Binder

Shig %

Activate the Design binder. Click Options =l >
System Options tab > FeatureManager. Select
Show from the drop-down menu. The Design
Binder is an embedded Microsoft Word
document that provides the ability for the user to
capture a screen image and to incorporate text
into a document.

ConfigurationManager

When you create various configurations for assemblies, design
tables, etc., use the comment area to incorporate a comment for
these configurations.

Dimensions

To be efficient, reuse existing geometry. Provide dimensions
with descriptive names.

Equations

Add a comment to the end of an equation to provide clarity for
the future. Use descriptive names and organize your equations
for improve clarity. SolidWorks equations ignore everything
from the right of the apostrophe.

Equations - BOX

R >
(@ )
%

= @' Design Binder

(@] sensors

§E I""|EI'2’E|Desi|;|n Journal.doc <Emphy
232 Fronk Plane
&> Top Plane
QSQ Right Flane
I_, Qrigin

Bill of Materials Options e

Part number displayed when
used in & bil of materials:

| For Customer ¥YZ |

|User Specified Mame v |

Don't show child components
[in B when used as
sub-assermbby

Dimension Propeties

Yalle: 2.700in

Mame: Depth for base

Full name: | Depth for base@sket

Active | Equation

[C T “lpattern-bottom@LPattern 1@CABINET Part” = 0.5 * (“box_widrh...

2 g

Evaluates... Comment
¥ 125mm
® om
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Design Tables

There are a number of ways to incorporate a comment into a design table. One way is to

add “SCOMMENT” to the heading of a column. This provides the ability to add a

comment in a design table.

Features

Always use descriptive names in the FeatureManager design tree, not the default feature
names such as Extrudel, Extrudel, LPattern1, etc. Group important features toward the

top of the FeatureManager design tree.
w1
* Enable the FeatureManager Name
feature on creation option, click Options
=l > System Options >
FeatureManager > Name feature on

[V]scroll selected item into view

fl\lame feature on creation
DArruw key navigation

Dynamic highlight

creation box. The Name feature on

Use transparent flyout FeatureManager in parts/assemblies

creation option highlights the feature name
when created and allows the feature to be
named.

Identify the Correct Reference
planes

Most SolidWorks features start with a 2D sketch. Sketches are
the foundation for creating features. SolidWorks provides the
ability to create either 2D or 3D sketches.

A 2D sketch is limited to a flat 2D Sketch plane. A 3D sketch
can include 3D elements. As you create a 3D sketch, the
entities in the sketch exist in 3D space. These entities are not
related to a specific Sketch plane as they are in a 2D sketch.

Does it matter where you start sketching? Yes! When you
create a new part or assembly, the three default planes are
aligned with specific views. The plane you select for your first
sketch determines the orientation of the part. Selecting the
correct plane is very important.

w1
“¥" The plane or face you select for the Base sketch
determines the orientation of the part.
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2D Sketching / Reference planes

The three default | reference planes,
displayed in the FeatureManager design
tree represent infinite 2D planes in 3D
space. They are:

e Front Right
Secondary Datum TFro;'lﬁ B
erfiary Datum

e Top
e Right

—
Planes have no thickness or mass.
Orthographic projection is the process
of projecting views onto parallel planes
with L projectors. The default L datum }
planes are:

HEIGHT

WIDTH e DEPTH

e Primary “Pag

e Secondary %
™S Top
o Prim ary Datum

e Tertiary e

.

Use the following planes in a h
manufacturing environment:
e Primary datum plane: Contacts the part at a minimum of three points
e Secondary datum plane: Contacts the part at a minimum of two points
e Tertiary datum plane: Contacts the part at a minimum of one point

The part view orientation depends on the sketch plane. Compare the Front, Top and Right
Sketch planes for an L-shaped profile in the following illustration.

L1

2D Profile Front Plane Top Plane Right Plane
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The six principle views of Orthographic projection listed in the ASME Y 14.3M standard
are: Front, Top, Right, Bottom, Rear and Left. SolidWorks Standard view names
correspond to these Orthographic projection view names.

ASME Y14.3M Principle View Name: SolidWorks Standard View:
Front Front

Top Top

Right side Right

Bottom Bottom

Rear Back

Left side Left

R Crverall drafting standard

% ANSI s the a1 P
defal}lt Overall I
drafting standard used >
in this book.

W L

Displayed is the Front, Top, Right
and Isometric view in Third Angle
Projection.

Tutorial: Default Reference Planes 4-1

Create a new part. Show the default
Reference planes in the Graphics window.

1. Click New [ from the Menu bar. The

Templates tab is the default tab. Part is the default template
from the New SolidWorks Document dialog box.

Bmcket views

T W
A Bracket
car i wnger 2

LrrTiar

Y (e lIES
T

| Sensars

2. Click OK. The Part FeatureManager is displayed. Use the 41 [A] Annotations
sketch Origin to help understand the (X,Y) coordinate §= Material <not specified>>

location of the sketch and to apply sketch dimensions. Each 8¢

sketch in the part has its own Origin.

3. Click Front Plane from the FeatureManager design tree.

@ Top Pl

\<§\ Right Plane
L Origin

Q% Partl (Defaulk<<Default=_Displa

o

The Front Plane is the Sketch plane in this example. The
Front Plane is highlighted in the FeatureManager and in the

Graphics window.

Show the default Reference planes in the Graphics window. ; ‘5‘

4. Hold the Ctrl key down.
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5. Click Top Plane and Right Plane from the FeatureManager

design tree el D »
. T :
6. Release the Ctrl key Q% I_:‘artl (Default< <Default=_Display
@ Sensors
7. Right-click Show & from the Context toolbar. If needed * gi:‘ e pectieds
click View, check Planes from the Menu bar. % T
8. Click inside the Graphics window. The three planes are g =
displayed in the Graphics window. Note the Plane icon in the L, orign/Fe
FeatureManager.
Rename the default Reference planes. eI ED B
(T )
9. Rename the Front Plane to Front-PlateA. @ Partt (Default<<Default» _Displa
10. Rename the Top Plane to Top-PlateB. . E ii:s;tr:tmns
11. Rename the Right Plane to Right-PlateC. 5 o ochet
* 4 op-Flate
12. Rebuild 8 the model. <~A§ it
I_. Origin

13. Close the model.

3D Sketching / Reference planes

Create a 3D sketch in SolidWorks. A 3D sketch is typically used for advanced features
such as Sweeps and Lofts. Most basic features are created from a 2D sketch.

w1
LN

See the Hole Wizard section for additional 3D sketch information.

There are two approaches to 3D sketching. The first approach is called 2D sketching with
3D Sketch planes. In this approach, you:

1. Activate a planar face by adding a 3D Sketch plane.
2. Sketch in 2D along the plane.

3. Add 3D Sketch planes each time you require to move sketch entities to create a 3D
sketch.

Using the 2D sketching with 3D Sketch planes approach provides the ability to:
e Add relations:

e Between planes

e Between sketch entities on different planes

e To planes

e Define planes

e Move and resize planes
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Tutorial: 3D Sketching 4-1
Create a simple 2D sketch with 3D Sketch planes.

1.

7.

Create a New U part in SolidWorks. Use the default
ANSI Part template.

Click Top Plane from the FeatureManager.

Click 3D Sketch On Plane from the Sketch Consolidated
toolbar as illustrated. 3DSketchl is active.

Click the Line  Sketch tool.

Sketch a vertical line through the origin.

Right-click Exit Sketch € from the
Context toolbar. 3DSketchl is

. . — | &
displayed in the FeatureManager. a I QO i%i
Close the model. T e o)

Tutorial: 3D Sketching 4-2

Create the illustrated model. Insert two
features: Boss-Extrudel and Cut-
Extrudel. Apply the 3D Sketch tool to

create the Cut-Extrudel feature. System
units = MMGS.

1.

Create a New U part in SolidWorks. Use the default ANSI,
MMGS Part template.

Right-click Front Plane from the FeatureManager. This is
your Sketch plane.

Click Sketch =4 from the Context toolbar. The Sketch
toolbar is displayed.

Click the Corner Rectangle L tool from the Consolidated

Rectangle Sketch toolbar. The PropertyManager is displayed.

Sketch a rectangle as illustrated. The part Origin is located
in the bottom left corner of the sketch.

Insert Dimensions.

6.

Right-click Smart Dimension € from the Context
toolbar.

Dimension the sketch as illustrated. The sketch is
fully defined. The sketch is displayed in black.

E © \-0O
Sketch | Smart
Dimrgsginn 0- -5
= - - &
@Sk&tch
&F |30 sketch
53 | 3D Sketch On Plane
P
Nl ED >
K? )

% PartZ {Defaulk<<Defaulk>_Displa

@ Sensors
+ |_£| Annotations

§E Material <not specified >
Z“} Front Plane
\<‘§ Top Plane
5 Right: Plane

;_, Qrigin
(-1 30Sketc]

?f 1

Origin

® 7[R | >
T )

% Part3 {Default<<Default>_Displa

Origin
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Create the first feature for the model. The Extruded Boss/Base feature adds material to a
part. Extrude the sketch to create the first feature.

8. Click Extruded Boss/Base 8 from the Features toolbar. Apply symmetry.

9. Select the Mid Plane End Condition in Direction 1.
Enter 100.00mm for Depth in Direction 1. Accept

the default conditions. Click OK ' from the
Boss-Extrude PropertyManager.
w1
AR Instant3D provides the ability to drag geometry
and dimension manipulator points to resize features or
to create new features directly in the Graphics window.
Click the face. Select a manipulator point. Click and
drag. Click a location along the ruler for the required
dimension. The rule increments are set in System
Options.

10. Create 3DSketch1. 3DSketchl is a four point Length increments
sketch. Click 3D Sketch On Plane from the Consolidated English units: E. 1in
Sketch toolbar as illustrated. Metric units: 10.00mm

11. Click the Line > Sketch tool. 3DSketchl is a four point

Angle increments: 1z

sketch as illustrated. 3DSketch1 is the profile for Cut-

Extrudel.
. . -G
12. Locate the first point of the sketch. Click the back right Sk%h _sgr; S Lo
bottom point as illustrated. Locate the second point of the pmenson | — E}
sketch. Click the top left front point as illustrated. Locate é% Sketchv
the third point of the sketch. Bs | 30 sketch
13. Click the bottom right front point as illustrated. AR 20 ctzh On ene
XY«
Locate the fourth point of the sketch. ¢
14. Click the back right bottom point as illustrated to close the I

sketch. P
Create the Cut-Extrudel feature.

15. Click Extruded Cut from the Features toolbar.
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16. Click the front right vertical edge as illustrated to remove the
material. Edge<1> is displayed in the Direction of Extrusions
box.

17. Click OK % from the Cut-Extrude PropertyManager. Cut-
Extrudel is displayed in the FeatureManager.

18. Close the model.

w1

“¥* You can either select the front right vertical edge or the Top
face to remove the require material in this tutorial.
¥ You can use any of the following tools to create 3D sketches:
Lines, All Circle tools, All Rectangle tools, All Arcs tools, Splines
and Points.

The second approach to create a 3D sketch with SolidWorks is 3D
sketching. In this approach:

1. Open an existing 3D sketch.

2. Press the Tab key each time you need to move your sketch
entities to a different axis.

Y ENED 2
F
L W arts (Defaul<<Default> Displa

I-»‘ﬁl Sensars
+ El Annokations
§E Makerial <not specified=
\<> Front Plane
Q Top Plane
\<> Right Flane
L, Crrigin
= @ Bioss-Extrudel
K= sketchi
= Cut-Extrudel
&5 3Dsketchi

w1
LN

The sketch origin is placed wherever you start your

sketch.

Tutorial: 3D Sketching 4-3

1. Open 3D Sketching 4-3 from the SolidWorks 2010 folder.

2. Right-click 3DSketch.

3. Click Edit Sketch & from the Context toolbar.
3DSketchl is displayed in the Graphics window.

4. Click the Line N Sketch tool. Note: The mouse
feedback icon

5. Click the right endpoint of the sketch as
illustrated.

6. Press the Tab key to change the Sketch plane from
XY to YZ. The YZ icon is displayed on the mouse
pointer.

7. Sketch a line along the Z axis approximately
130mm as illustrated.

8. Press the Tab key twice to change the sketch

plane from YZ to XY. The XY icon is displayed
on the mouse pointer.
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9. Sketch a line back along the X axis approximately

30mm.

10. Sketch a line on the Y axis approximately 30mm.

11. Sketch a line along the X axis of approximately

130mm.
Deselect the Line Sketch tool.
12. Right-click Select. View the 3D Sketch.
13. Rebuild 8 the model.
14. Close the model.

2D Sketching / Inserting Reference planes

Reference Planes are geometry created from existing planes, faces,
vertices, surfaces, axes, and or sketch geometry. To access the
Plane PropertyManager, click Insert > Reference Geometry >

Plane from the Menu bar or click the Plane tool & from the
Consolidated Reference Geometry Features toolbar.

Plane Tool

The Plane & tool uses the Plane
PropertyManager. The Plane
PropertyManager (new in 2010) provides the
following selections:

e First Reference. Select a face, plane or
edge to create a reference plane. The
options are available:

e Reference Entities. Displays the
selected planes either from the
FeatureManager or from the Graphics
window.

e Parallel. Creates a plane through a
point parallel to a plane or a face.

Reference Ge... [%]

i Fan
Reference Curves Insgr:tSD
Geometry

lane

is

Coordinate Syskem
# |Poink
E@ Mate Feference

e Perpendicular. Creates a plane through a point

perpendicular to a plane or a face.

MEET K [EgAED |
[Srane 7|
« KB « KB
Message S Message a
Select references and constraints Fully defined
First Reference & First Reference a
m m I Face<1>
Second Reference a |§| Parallel
@ I |I| Perpendicular
Third Reference 2 |é| Ttz
o8 jfooodes ]
@ -
[ Aip
< =
|///| Mid Plane
Second Reference o
o ]
Third Reference &
v

e Coincident. Creates a plane through a point coincident to a

plane or a face.

e Angle. Creates a plane through an edge, axis, or sketch line at an angle to your
plane or face. Enter the angle value in the angle box.
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e Distance. Creates a plane parallel to a face or plane, which is offset by your
specified distance. Enter the Offset distance value in the distance box.

e Reverse direction. Reverses the direction of the angle if required.
e Numbers of Planes to Create. Displays the selected number of planes.
e Mid Plane. Equally spaced on both sides.

Tutorial: Insert Reference Planes 4-2

Create three Reference planes using the Offset Distance
option from the Plane PropertyManager.

1. Create a New L part in SolidWorks. Use the default
ANSI Part template. Set system units to MMGS.

2. Display an Isometric view.

3. Right-click Top Plane from the FeatureManager
design tree.

4. Hold the Ctrl key down. . %%%
Click and drag the boundary of the Top Plane - l\ 2
upwards in the Graphics window. The Plane "
PropertyManager is displayed. Top Plane is b
displayed in the First Reference box. )
6. Release the Ctrl key and mouse pointer.
7. Enter 25mm in the Distance. The Plane is offset by 3
8. Enter 3 in the Number of planes to create box. 4 | e
9. Click OK # from the Plane PropertyManager. < B a b
Planel, Plane2 and Plane3 are created and are . P A o

displayed in the Graphics window. Each Plane is
offset from the Top Plane a distance of 25mm.

10. Close the part.

Tutorial: Angled Reference Plane 4-3
Use the Plane PropertyManager to create two angled
Reference planes from an edge at a 45 degree angle.

1. Open Angled Reference Plane 4-3 from the
SolidWorks 2010 folder.

2. Click Right Plane from the FeatureManager
design tree.
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3. Click Insert > Reference Geometry > Plane from
the Menu bar. The Plane PropertyManager is
displayed. Right Plane is displayed in the First
Reference box.

4. Click the At angle button.
5. Enter 45deg for Angle.

6. Click the front vertical edge of Extrudel as
illustrated. Do not select the midpoint. Edge<1> is
displayed in the Selections box. The model is fully
defined.

7. Enter 2 in the Number of planes to create box.

8. Click OK # from the Plane PropertyManager. Planel
and Plane?2 are displayed in the FeatureManager and in the
Graphics window.

9. Close the model.

Tutorial: Reference Plane 4-4

Use the Plane PropertyManager to create a
Reference plane using three vertices of Extrudel.

1. Open Reference Plane 4-4 from the
SolidWorks 2010 folder.

2. Click Insert > Reference Geometry > Plane.
The Plane PropertyManager is displayed.

3. Click three Vertices as illustrated. Vertex<1>,
Vertex<2> and Vertex<3> are
displayed in the Reference
Entities boxes. The model is
fully defined.

4. Click OK # from the Plane
PropertyManager. The angled
Planel is created and is
displayed in the FeatureManager
and the Graphics window.

5. Close the model.

Tutorial: Reference Plane 4-5

Use the Plane PropertyManager to create a Reference
plane parallel to an existing plane, through a selected
point.
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1. Open Reference Planes 4-5 from the SolidWorks 2010 folder. ¥ | ¥ ™
Reference | Curves =
2. Click the Plane tool from the Consolidated Reference Geometry GE°”:E“V ' it
Features toolbar. The Plane PropertyManager is displayed. S Pla%e
3. Click the front top right vertex. | s s

4. Click the Right Plane from the fly-out FeatureManager.
The model is fully defined.

5. Click OK # from the Plane PropertyManager. Planel is

created and is displayed in the FeatureManager and
Graphics window.

%
6. Close the model.

N

Parent/Child Relationship

A Parent feature or sketch is an existing feature or sketch on which others depend on.
Example of a Parent feature: An Extruded feature is the Parent feature to a fillet which
rounds the edges.

When you create a new feature or sketch which is based on other features or sketches,
their existence depends on the previously built feature or sketch. The new feature or
sketch is called a Child feature or a Child sketch. Example of a Child feature: A hole is
the child of the Base-Extrude feature in which it is cut.

Tutorial: Parent-Child 4-1

View the Parent/Child relationship in an assembly for a sketch and a feature from a
component.

1. Open the AirCylinder Linkage assembly from the | - %I%jdﬂ::::: o Spetaul> Dl e 1)
SolidWorks 2010\Solutions folder. i @ e
2. Expand RodClevis<1> from the AirCylinder %:::;‘5' epaiess
Linkage assembly FeatureManager. @ Top
3. Expand Base-Extrude from the FeatureManager %;g.;tn
] 5 : 5 Base-Extrude
?’Zsifﬁt;réailﬁllg%lﬁecgzlr(erslb gtlfllllg ‘R(;lll:tli(onships % %S:;t:ufea
dialog box is displayed. View the Sketch2
relationships. F T —
4. Click Close from the Parent/Child Relationships | "¢ ... Chi'd@é s
dialog box. s D
View the Parent/Child Relationships for a feature. " i'jf;';:mdes
5. Right-click Base-Extrude from the + E:f.n;zfda
FeatureManager design tree. CorBames

6. Click Parent/Child. View the Base-Extrude feature relationships.
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7. Click Close from the Parent/Child Relationships dialog box.
8. Close the model.

Sketch States

Sketches can exist in any of five states. The state of the sketch is displayed in the status
bar at the bottom of the SolidWorks window. The five sketch states in SolidWorks are:

n s
AT

Color indicates the state of the individual Sketch entities.

1. Under Defined. Inadequate definition of the sketch, (blue). The FeatureManager

displays a minus (-) symbol before the Sketch name.

2. Fully Defined. Complete information, (black). The FeatureManager displays no

symbol before the Sketch name.

3. Over Defined. Duplicate dimensions and or relations, (red). The FeatureManager
displays a (+) symbol before the Sketch name. The What’s Wrong dialog box is

displayed.

4. Invalid Solution Found. Your sketch is solved but results in
invalid geometry. Example: such as a zero length line, zero
radius arc or a self-intersecting spline (yellow).

5. No Solution Found. Indicates sketch geometry that cannot be
resolved, (Brown).

w1
“¥" The SolidWorks SketchXpert is designed to assist in an over
defined state of a sketch. The SketchXpert generates a list of
causes for over defined sketches. The list is organized into
Solution Sets. This tool enables you to delete a solution set of
over defined dimensions or redundant relations without

compromising your design intent.

w1

‘¥ With the SolidWorks software, it is not necessary to fully
dimension or define sketches before you use them to create
features. You should fully define sketches before you consider the

part finished for manufacturing.

A Click Options > System Options > Sketch, and click
the Use fully defined sketches option to use fully defined
sketches for created features.

w 1

“¥" The plane or face you select for the Base sketch determines
the orientation of the part.
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Sketch Entities

Sketch entities provide the ability to create lines,
rectangles, parallelograms, circles, etc. during the
sketching process. To access the available sketch
entities for SolidWorks, click Tools > Sketch
Entities from the Menu bar menu and select the
required entity. This book is targeted towards a
person with a working knowledge of SolidWorks.
The book will not go over each individual Sketch
entity in full detail but will address the more
advance entities.

To obtain additional information of each sketch
entity, active the sketch entity and click the
question mark M4 icon located at the top of the
entity PropertyManager or click Help >
SolidWorks Help Topics from the Menu bar and
search by using one of the three available tabs:
Contents, Index, or Search.

Line Sketch entity

DUHOE 0RVDEO0RSCHOS

Line
Rectangle

Center Rectangle

3 Point Corner Rectangle

3 Point Center Rectangle

Parallelogram
Straight Slok

Centerpoint Straight Slok

3 Paink Arc Slot
Centerpoint Arc Slot

Polygon

Circle

Perimeter Circle
Centerpoink Arc
Tangent Arc

3 Poink Arc

@ Elipse

ﬁ Partial Ellipse

U Parabola

r\J Spline

Spline on Surface

r\t Equation Driven Curve
#* | Paoint

Centetline

A Text...
&3 | Plane

%4

Custamize Menu

NS
The Line Sketch entity N tool provides the ability to sketch
multiple 2D lines in a sketch. The Line Sketch entity uses the Insert
Line PropertyManager. The Insert Line PropertyManager provides

the following selections:

e Orientation. The Orientation box provides the following

options:

e As sketched. Sketch a line in any direction using the click
and drag method. Using the click-click method, the As
sketched option provides the ability to sketch a line in any
direction, and to continue sketching other lines in any
direction, until you double-click to end your process.

e Horizontal. Sketch a horizontal line until you release your

mouse pointer.

e Vertical. Sketch a vertical line until you release your mouse

pointer.

e Angle. Sketch a line at an angle until you release your

mouse pointer.
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The angle is created relative to the horizontal.

e Options. The Options box provides two line types. They are:  [options

e For construction. Converts the selected sketch entity to

=

[JFar construction

construction geometry. Aiiieeh
¢ Infinite length. Creates a line of infinite length which
you can later trim in the design process.
s 1.
“¥* Use Construction geometry to assist in creating your sketch
entities and geometry that are ultimately incorporated into the
part. Construction geometry is ignored when the sketch is used
to create a feature. Construction geometry uses the same line
style as a centerline.
Rectangle and Parallelogram Sketch  Rectanale :
E ntity Rectangle Type A
B =
The Rectangle Sketch entity B tool provides the ability to 1 1 —
sketch a Corner Rectangle, Center Rectangle, 3 Point Corner g ‘ ‘g |
Rectangle and a 3 Point Center Rectangle. The Parallelogram
Sketch entity provides the ability to sketch a Parallelogram. Parameters A
The Rectangle and Parallelogram Sketch entity uses the _x %
Consolidated Rectangle PropertyManager. The Rectangle i
PropertyManager provides the following selections: _" ESR
o Rectangle Type. The Rectangle Type box provides five oo ]
selections. They are: ., |:|
e Corner Rectangle. Sketch a standard rectangle at a corner «[ooo |
point. Click to place the first corner of the rectangle, drag, “[ooo |

and release when the rectangle is the correct size and shape.

e Center Rectangle. Sketch a rectangle at a center point.
Click to define the center. Drag to sketch the rectangle with
centerlines. Release to set the four edges.

e 3 Point Corner Rectangle. Sketch a rectangle at a selected
angle. Click to define the first corner. Drag, rotate, and then
release to set the length and angle of the first edge. Click
and drag to sketch the other three edges. Release to set the

four edges.
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e 3 Point Center Rectangle. Sketch a rectangle with a
center point at a selected angle. Click to define the first
corner. Drag and rotate to set one half the length of the
centerlines. Click and drag to sketch the other three
edges and centerlines. Release to set the four edges.

e Parallelogram. Sketch a standard parallelogram. A
Parallelogram is a rectangle whose sides are not
horizontal or vertical with respect to the sketch grid.
Click to define the first corner. Drag, rotate, and then
release to set the length and angle of the first edge. K
Click, rotate, and drag to set the angle and length of the o
other three edges. Release to set the four edges.

e Parameters. Specify the appropriate combination of
parameters to define the rectangle or parallelogram if they
are not constrained by relations.

Slot Sketch entity

o
. § . oy Slot Types &
The Slot Sketch entity tool provides the ability to sketch a Y=
Straight Slot, Centerpoint Straight Slot, 3 Point Arc Slot and a
Centerpoint Arc Slot from the Consolidated Slot toolbar. ——
The Slot Sketch entity uses the Consolidated Slot _ ‘
PropertyManager. The Slot PropertyManager provides the []Add dimensions
following selections: =
;i[l l]Jé.iE+ B
e Slot Type. The Slot Type box _ Ju
provides four selections. They are:
+ + Parameters A
e Straight Slot. Sketch a three / / o
point slot. O
e Centerpoint Straight Slot. OF | |

located at an Origin or
centerpoint. ’ ’

Sketch a three point slot < | § 8 | |
S/

e 3 Point Arc Slot. Sketch a four point
arc slot.

e Centerpoint Arc Slot. Sketch a four
point arc slot located at an Origin or
reference point. l_
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e Add dimensions. Insert dimensions as you * - 244,13
sketch the slot.

7728( +——-*-—-+Neo

e Center to Center. Insert center to center
dimension if the Add dimensions box is checked. *

e Overall Length. Insert overall length if the Add
dimensions box is checked.

e

e Parameters. Provides the ability to specify the 1815 +—-—-——-—- +
appropriate combination of parameters to define slot i \_
if they are not constrained by relations. The
parameters box provides the following options: Parameters
Center X Coordinate, Center Y Coordinate,
Radius of Arc, Angle of Arc, Slot Width and Slot
Length.

i

F6.383475935mm
14, 59962257mm

36, 25865392mm

Utilize the Slot Sketch tool. Create an Extruded 27 34539 768mm

(%
5
A
Tutorial: Slot Sketch - Instant3D 4-1 [y | sa.3m8545a60e0
a3
Boss/Base and Extruded Cut feature using the Instant3D a8

83,2535768%mm

tool.

1. Create a New L part in SolidWorks. Use the default
ANSI, IPS Part template.

2. Right-click Front Plane from the FeatureManager. —
This is your Sketch plane. eHe N-* .

. E kraight Slof
3. Click Sketch *=. from the Context toolbar. The Centerpoint Straight Siot

Sketch toolbar is displayed. AT @ |3 raint arc slat

4. Click Centerpoint Straight Slot & from the €7 | Centerpork Arc Slot
Consolidated Slot toolbar as illustrated. The Slot
PropertyManager is displayed. If needed, uncheck

the Add dimension box. ~ = i’ %@
5. Click the Origin. + / /+

6. Click a position directly to the right of the Origin.

7. Click a position directly above the second point as
illustrated.

! ! R.50
Dimension the slot sketch. L
8. Right-click Smart Dimension € from the (— ----------- _

Context toolbar in the Graphics window.

9. Dimension the model as illustrated. The
sketch is fully defined.
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Apply the Instant3D tool. Create an Extruded Boss/Base feature.

The Extruded Boss/Base feature adds material to a part. Note:

Edit the feature, view the PropertyManager to confirm that you Reference CUZr{es Inséﬁ‘m
picked the correct dimension with the on-screen ruler. B
Exit Sketchl.

10. Right-click Exit Sketch. Note: Instant3D is active by
default. If needed click Instant3D from the Features tab.

11. Display an Isometric view.

Create an Extruded Boss/Base
feature with a default Blind End
Condition.

12. Click the top edge as
illustrated. A green arrow is
displayed.

13. Drag the green arrow forward
and click the on-screen ruler at
the 0.25 dimension. View Boss-Extrudel in the
FeatureManager. Depth = .25in.

Create an Extruded Cut feature using Instant3D.
14. Display a Front view.
15. Right-click the Front face. This is you Sketch plane.

16. Click Sketch .E. from the Context toolbar. The Sketch
toolbar is displayed.

17. Click the Circle @ Sketch tool.

18. Sketch a circle centered at the Origin as illustrated.
Exit the Sketch.

19. Right-click Exit Sketch.

20. Display an Isometric view.
Create an Extruded Cut feature.

21. Click the circumference of the sketch as illustrated. A
green arrow is displayed.

22. Click a drag the green arrow backwards to create a hole in
the model. Note: The default End Condition is Blind.

23. Release the mouse icon behind the model. The Cut-
Extrudel feature is displayed. View the model.

24. Close the model.
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Polygon Sketch Entity

The Polygon Sketch entity % tool provides the ability to create
equilateral polygons with any number of sides between 3 and 40. The
Polygon Sketch entity uses the Polygon PropertyManager. The
Polygon PropertyManager provides the following selections:

e Existing Relations. The Existing Relations box displays
information on existing relations of the polygon sketch.

e Add Relation. The Add Relation box displays the selected
relations to the points and lines of your polygon sketch.

w1

“¥* You can not add a relation to a complete polygon. You can only
add a relation to the points and lines of the polygon.

e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected sketch entity to construction geometry.

e  Parameters. The Parameters box provides the ability to specify
the appropriate combination of parameters to define the polygon.
When you modify or change one or more parameters, the other
parameters update automatically. The available selections are:

e Number of Sides. Sets the number of sides in your polygon.

e Inscribed circle. Selected by default. Displays an inscribed
circle inside the polygon. This option defines the size of the
polygon. The circle is construction geometry.

e Circumscribed circle. Displays a circumscribed circle
outside of the polygon. This option defines the size of the
polygon. The circle is construction geometry.

e Center X Coordinate. Displays the X coordinate for the
center of your polygon.
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e Center Y Coordinate. Displays the Y coordinate for the
center of your polygon.

e Circle Diameter. Displays the diameter of the inscribed or
circumscribed circle.

e Angle. Displays the angle of rotation.

e New Polygon. Creates more than a single polygon without
leaving the PropertyManager.

Tutorial: Polygon 4-1
Create a new part using the Polygon Sketch entity.

1. Create a New L part in SolidWorks. Use the default ANSI
Part template.

N ER RS >
(? .

% Parté (Default < <Default=_Display
(] Sensors
+ [ A] Annotations

2. Right-click Top Plane from the FeatureManager design tree.
This is your Sketch plane.

3. Click Sketch £ from the Context toolbar. The Top Plane
boundary is displayed in the Top view in the Graphics
window.

4. Click the Circle @ Sketch tool. The Circle PropertyManager
is displayed.

5. Sketch a circle centered at the origin. The mouse cursor

% |f‘J - i3 E'IE
displays the Circle icon symbol @ . _| fi Al it ites
+] - ¥ = -

Insert a polygon.

6. Click Tools > Sketch Entities > Polygon from the
Menu bar or click Polygon from the Sketch toolbar.
The Polygon PropertyManager is displayed. The mouse

e | Dimxpert | Office Products

Polygon
Sketches a polygon, ¥ou can change the
rumber of sides after sketching the
palygan,

cursor displays the Polygon icon symbol .

7. Sketch a Polygon centered at the Origin larger than the
circle as illustrated.

8. Click OK # from the Polygon PropertyManager.

9. Rebuild B the model. View the created Polygon in the
Graphics window.

10. Close the model.

w1

‘¥* For illustration purposes, the Reference planes and grid are
hidden.
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= = I_ Circle 'ﬁm B
Circle Sketch and Perimeter 3 v
Circle Sketch Entity crdeType  4l|crdetype 2
The Circle Sketch and Perimeter Circle Sketch ‘— — ‘— —
entity % tool provides the ability to control the | EtingRelations 4} | Bxisting Relations 2
. . . b |coincidento L
various properties of a circle.
The Circle Sketch and Perimeter Circle Sketch
entity uses the consolidated Circle
PropertyManager. The consolidated Circle @ under Defined ] Underlisined
PropertyManager provides the following Add Relations 3| | Add Relations A
selections: (1] Fix (8] Fix
e Circle Type. Provides the ability to select Options A | Gptions —
either a center based circle or a perimeter- [For construction [JFer construction
based circle sketch entity. Parameters #| | Parameters A
. . - . & [s40423313 |2 || & [000 2
e [Existing Relattons. The. Ex1stlpg Relations ® (oose0060 & oo -
box provides the following options: - .
| A 1580447853 |2

e Relations. Displays the automatic
relations inferenced during sketching or
created manually with the Add Relations
tool. The callout in the Graphics window
is highlighted when you select a relation
in the dialog box. The Information icon
in the Existing Relations box displays the sketch status of the
selected sketch entity. Example: Under Defined, Fully
Defined, etc.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the selected entity.

e Options. The Options box provides the following selection:

¢ For construction. Not selected by default. Converts the selected entity to
construction geometry.

e Parameters. Specifies the appropriate combination of parameters to define the circle
if the circle is not constrained by relations. The available selections are:

e Center X Coordinate. Sets the Center X Coordinate value.
e Center Y Coordinate. Sets the Center Y Coordinate value.

e Radius. Sets the Radius value.
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The Perimeter Circle Sketch entity % provides the ability to
define a circle using 3 points along its perimeter. This sketch
entity is very usefully when you are not concern about the
location of the center of the circle.

Tutorial: Perimeter Circle 4-1

Create a Perimeter Circle sketch.

1. Create a New L part in SolidWorks. Use the default ANSI
Part template.

2. Right-click Front Plane from the FeatureManager. This is
your Sketch plane.

3. Click Sketch & from the Context toolbar.

4. Click the Line \ Sketch tool. The Insert Line
PropertyManager is displayed.

5. Sketch two lines as illustrated.

Sketch a circle that is tangent to both lines.

6. Click Perimeter Circle from the Consolidated Circle Sketch
toolbar. The Circle PropertyManager is displayed.

7. Click each line once.

8. Click a position as illustrated to determine the size of the
circle. The X coordinate, Y coordinate, and Radius is
displayed in the Parameters box. The two lines are tangent
to the circle. You created a simple circle using the Perimeter
Circle sketch entity.

9. Click OK # from the Circle PropertyManager. View the
model.

10. Rebuild 8 the model.

11. Close the model.

If the two lines change, the circle remains

tangent to the lines.

w1

-

O - 51 g
;@Circle

@ |Perimeter Circle

" In System Options, apply the Ghost image on Gliostin SR bua
drag option. The option displays a ghost image of a
sketch entities' original position while you drag the
sketch in the Graphics window.

hk‘i- hov curvature comb bounding curve
|:| Enable on screen numeric input on entity creation

Civer defining dimensions
Prompt ko set driven state

Set driven by defaulk
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Centerpoint Arc Sketch Entity

The Centerpoint Arc Sketch entity = tool provides the ability to
create an arc from a centerpoint, a start point, and an end point. The
Centerpoint Arc Sketch entity uses the consolidated Arc
PropertyManager.

The Arc PropertyManager controls the properties of a sketched
Centerpoint Arc, Tangent Arc and 3 Point Arc.

The consolidated Arc PropertyManager provides the following
selections:

Arc Type: Provides the ability to select a Centerpoint Arc,
Tangent Arc or 3 Point Arc sketch entity.

Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add Relations
tool. The callout in the Graphics window is highlighted
when you select a relation in the dialog box. The
Information icon in the Existing Relations box displays the
sketch status of the selected sketch entity. Example: Under
Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.

Options. The Options box provides the following selection:

e For construction. Converts the selected entity to
construction geometry.

Parameters. Provides the ability to specify any appropriate
combination of parameters to define your arc if the arc is not
constrained by relations. The available selections are: Center X
Coordinate, Center Y Coordinate, Start X Coordinate, Start
Y Coordinate, End X Coordinate, End Y Coordinate,
Radius and Angle.

w1

-

* Press the g key to activate the Magnifying glass
tool. Use the Magnifying glass tool to inspect a model
and make selections without changing the overall view.
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Tutorial: Certerpoint Arc 4-1
Create a Centerpoint Arc sketch.

1.

10.

11.
12.

13

Create a New U part in SolidWorks. Use the default
ANSI Part template.

Right-click Front Plane from the FeatureManager.
This is your Sketch plane.

Click Sketch £ from the Context toolbar.
Click the Line ™\ Sketch tool.

Sketch a horizontal line through the origin as
illustrated.

Click Centerpoint Arc “2 from the Consolidated Arc
Sketch toolbar. The Arc icon is displayed on your
mouse pointer.

Click a location on the horizontal line left of the origin.
Do not pick the origin or the endpoint.

Click a position to the right and up on the horizontal
line.

Drag to set the angle and the radius of the arc.

Release the mouse button to place the arc. View the Arc
PropertyManager and the coordinates.

Click OK % from the Arc PropertyManager.
Rebuild 8 the model.

. Close the model.

Tangent Arc Sketch Entity

Ve

1
| .

The Tangent Arc Sketch entity 2 tool provides the ability to create an arc, which is
tangent to a sketch entity. The Tangent Arc Sketch entity uses the Arc PropertyManager.
View the Centerpoint Arc Sketch entity section above for additional information on the
Arc PropertyManager.

w1

“¥* You can transition from sketching a line to sketching a Tangent Arc, and vice versa
without selecting the Arc tool from the Sketch toolbar. Example: Create a line. Click the
endpoint of the line. Move your mouse pointer away. The Preview displays another line.
Move your mouse pointer back to the selected line endpoint. The Preview displays a
tangent arc. Click to place the arc. Move the mouse pointer away from the arc endpoint.
Perform the same procedure above to continue.
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Tutorial: Tangent Arc 4-1

Create a Tangent Arc sketch. A=A ED >
T .
1. Create a New L part in SolidWorks. Use the default ANSI % Part7 (Default<<Default> Display
Part template. 1] s=nsars
+-LA] A=
2. Right-click Front Plane from the FeatureManager. g-g g W
3. Click Sketch & from the Context toolbar. % TofFetm
& Rig B2 | 2D Sketch On Plane
4. Click the Line \ Sketch tool. L or Section Yiew
5.

Sketch a horizontal line through the
Origin.

6. Click Tangent Arc D from the
Consolidated Arc Sketch toolbar. The Arc

. .. . E =
icon is displayed on the mouse pointer. o &

Click the left end point of the horizontal =
line.

7. Drag the mouse pointer upward and to the left for the desired shape.

8. Click an end point. You created a Tangent Arc. The Arc PropertyManager is
displayed.

9. Right-click Select in the Graphics window to deselect the Sketch tool.

10. Click OK % from the Arc PropertyManager.
11. Exit the sketch. Close the model.

w 1

“¥" You can select an end point of a line, ellipse, arc or a spline. The Tangent Arc tool
creates both Normal and Tangent Arcs.

3 Point Arc Sketch Entity

The 3 Point Arc Sketch entity ;‘:‘% tool provides the ability create an
arc by specifying three points; a starting point, an endpoint, and a
midpoint. View the Centerpoint Arc Sketch entity section for
additional information on the Arc PropertyManager.

Tutorial: 3Point Arc 4-1
Create a 3Point Arc sketch. 0.5
1. Open 3Point Arc 4-1 from the SolidWorks 2010 folder. D@ - A

iy enkerpoink Arc

2. Edit Sketchl.

-JE) Tangent Arc
3. Click 3Point Arc ¢ from the Consolidated Arc Sketch toolbar. £y | 3 Paint Arc
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4. Click the top point of the vertical line for the start point as
illustrated.

5. Click the right point of the open circle for the end point as
illustrated.

Drag the arec downward to set the radius.

Click a position for the midpoint of the 3Point Arc.

Click OK + from the Arc PropertyManager.
Rebuild 8 the model. Close the model. >

A 2

Ellipse Sketch Entity

lﬁ:urr:n!—ﬁ
v

The Ellipse Sketch entity } tool provides the ability to create a et Relatons .

complete ellipse. The Ellipse PropertyManager controls the n 2

properties of a sketched Ellipse or a Partial Ellipse. The Ellipse
PropertyManager provides the following selections:

e Existing Relations. The Existing Relations box provides the

. . Under Cefined
following options: i

»

. . . . . Add Relations
e Relations. Displays the automatic relations inferenced () Fix

during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box.
The Information icon in the Existing Relations box displays | Parameters

the sketch status of the selected sketch entity. Example: & |-s223623552
Under Defined, Fully Defined, etc. & [s1.6489%72

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.

»

Options

[]For construction

»

4% |4k |5k (4|

¢ [&.09823093

e Options. The Options box provides the following selection:

e For construction. Converts the selected entity to
construction geometry.

e Parameters. Provides the ability to specify any appropriate
combination of parameters to define the ellipse if the ellipse is
not constrained by relations. The available selections are:
Center X Coordinate, Center Y Coordinate, Start X
Coordinate (only available for a Partial Ellipse), Start Y
Coordinate (only available for a Partial Ellipse), End X
Coordinate (only available for a Partial Ellipse), End Y
Coordinate (only available for a Partial Ellipse), Radius 1,
Radius 2 and Angle (only available for a Partial Ellipse).
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Tutorial: Ellipse 4-1
Create an Ellipse sketch.

1. Create a New U part in SolidWorks. Use the I

default ANSI Part template.
efau art template o %A

2. Right-click Front Plane from the & Blipse

FeatureManager. This is your Sketch plane. (7 Partial Elipse
U Parabola

3. Click Sketch & from the Context toolbar.

4. Click the Ellipse & Sketch tool. The Ellipse icon is
displayed on the mouse pointer.

5. Click a location in the Graphics window. This is the start
location.

6. Drag and click to set the major axis of the ellipse. The ellipse
PropertyManager is displayed.

7. Drag and click again to set the minor axis of the ellipse.

8. Right-click Select in the Graphics window.

Add a Vertical relation.

9. Hold the Ctrl key down.

10. Click the top vertical point and the bottom vertical point of
the Ellipse.

11. Release the Ctrl key. The Properties PropertyManager is
displayed.

12. Click Vertical from the Add Relations box. Note: You can
also use the pop-up Context toolbar and click Make Vertical.

13. Click OK # from the Properties PropertyManager.

14. Rebuild 8 the model. View the sketch.

15. Close the model.

Partial Ellipse Sketch Entity

»

Add Relations

— |Horizontal

,( Coincident
8 | Fix

é—)‘\

M B

The Partial Ellipse Sketch entity } tool provides the ability to create a partial ellipse or
an elliptical arc from a centerpoint, a start point, and an end point. You use a similar
procedure when you created a Centerpoint Arc. The Ellipse PropertyManager controls the
properties of a sketched Ellipse or a Partial Ellipse. View the Ellipse section for
additional information on the Ellipse PropertyManager.

Page 4 - 31




Design Intent, Sketching and Sketch Entities

Parabola Sketch Entity

The Parabola Sketch entity WV tool provides the ability to create a
parabolic curve. The Parabola Sketch entity uses the Parabola
PropertyManager. The Parabola PropertyManager provides the
following selections:

e Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add Relations
tool. The callout in the Graphics window is highlighted when
you select a relation in the dialog box. The Information icon
in the Existing Relations box displays the sketch status of the
selected sketch entity. Example: Under Defined, Fully
Defined, etc.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.

e Options. The Options box provides the following selection:

e For construction. Not selected by default. Converts the
selected entity to construction geometry.

e Parameters. Provides the ability to specify the appropriate
combination of parameters to define the parabola if the parabola
is not constrained by relations. The available selections are:
Start X Coordinate, Start Y Coordinate, End X Coordinate,
End Y Coordinate, Center X Coordinate, Center Y
Coordinate, Apex X Coordinate and Apex Y Coordinate.

Tutorial: Parabola 4-1
Create a Parabola sketch.

1. Create a New L part in SolidWorks. Use the default ANSI, IPS
Part template.

2. Right-click Front Plane from the FeatureManager. This is your
Sketch plane.

3. Click Sketch & from the Context toolbar.

4. Click the Parabola \J Sketch tool from the Consolidated Sketch

toolbar. The Parabola icon is displayed on the mouse pointer.

Page 4 - 32

o
Existing Relations A
L

€ Under Defined

=

Add Relations
(s Fix

=

Options
[JFor construction

=

Parameters
(Y |-11.45918932
(Y | 534380253

(% |-11.97371449
(¥ [ 53.73822788

(7 [-20.39791411
(% [4.3709815

(" [13.51030675

I L A A (M L A 2

(" [3z2.45122699

& |Elipse
¢7 |Partial Elipse
Farabola




8.
9.

Design Intent, Sketching and Sketch Entities

Click a position in the Graphics window to locate the
focus of your parabola.

Drag to enlarge the parabola. The parabola is outlined.

Click on the parabola and drag to define the extent of the
curve. The Parabola PropertyManager is displayed.

Click OK # from the Parabola PropertyManager.

Rebuild 8 the model.

10. Close the model.

Spline Sketch Entity

The Spline Sketch entity

~ tool provides the ability to create a

profile that utilizes a complex curve. This complex curve is called a
Spline, (Non-uniform Rational B-Spline or NURB). Create a spline
with control points. With spline control points, you can:

Use spline points as handles to pull the spline into the shape you
want.

Add dimensions between spline points or between spline points
and other entities.

Add relations to spline points.

The 2D Spline PropertyManager provides the following selections:

Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add
Relations tool. The callout in the Graphics window is
highlighted when you select a relation in the dialog box. The
Information icon in the Existing Relations box displays the
sketch status of the selected sketch entity. Example: Under
Defined, Fully Defined, etc.

Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.

Options. The Options box provides the following selection:
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e For construction. Not selected by default. Converts the
selected entity to construction geometry. [ Curvature Scale__ 7 |
<

e Show Curvature. Not selected by default. Provides the
ability to control the Scale and Density of the curvature.
Displays the Curvature of the spline in the Graphics
window.

Scale A

25

4

»

e Raised degree. Only available with splines that include Density
curvature handles at each end. Raises or lowers the degree
of the spline. You can also adjust the degrees by dragging 9
the handles.

4

e Standard. Only available with splines that include
curvature handles at each end. Displays when you first
create the spline or if Raised degree is cleared.

e Maintain Internal Continuity. Selected by default.

e Parameters. Provides the ability to specify the appropriate
combination of parameters. The available parameters are:

e Spline Point Number. Highlights your selected spline
point in the Graphics window.

e X Coordinate. Specifies the x coordinate of your spline
point.

e Y Coordinate. Specifies the y coordinate of your spline
point.

e Radius of Curvature. Controls the radius of curvature at
any spline point. This option is only displayed if you select
the Add Curvature Control option from the Spline toolbar,
and add a curvature pointer to the spline.

e Curvature. Displays the degree of curvature at the point
where the curvature control was added. This option is only
displayed if you add a curvature pointer to the spline.

e Tangent Weightingl. Controls the left tangency vector by modifying the spline’s
curvature at the spline point.

e Tangent Weighting 2. Controls the right tangency vector by modifying the
spline’s curvature at the spline point.

e Tangent Radial Direction. Controls the tangency direction by modifying the
spline’s angle of inclination relative to the X, Y or Z axis.
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e Tangent Polar Direction. Controls the elevation angle of the tangent vector with
respect to a plane placed at a point perpendicular to a spline point. This is only for
the 3D Spline PropertyManager.

e Tangent Driving. Enables spline control by using the Tangent Magnitude option
and the Tangent Radial Direction option.

e Reset This Handle. Returns the selected spline handle to the initial state.
e Reset All Handles. Returns the spline handles to their initial state.

e Relax Spline. Sketch your spline and display the control polygon. You can drag
any node on the control polygon to change shape. If your dragging results in a
spline which is not smooth, re-select the spline to display the PropertyManager.
Click the Relax Spline selection under the Parameters option. This will re-
parameterize or smooth the shape of your spline.

e Proportional. Retains the spline shape when you drag the spline.

Spline toolbar

Use the tools located on the Spline toolbar to control

properties of a sketched spline. The Spline toolbar

provides the following tools: 772k DAAR
e Add Tangency Control. The Add Tangency Control

tool E4 adds a tangency control handle. Drag the
control handle along the spline and position it to control the tangency at the selected
point.

e Add Curvature Control. The Add Curvature Control tool %O adds a curvature control
handle. Drag the control handle along the spline and position the control handle to
control the spline shape at the selected point.

e Insert Spline Point. The Insert Spline Point tool ~ adds a point to the spline. Drag
spline points to reshape the spline.

w1
AT

You can insert dimensions between the spline points.
e Simplify Spline. The Simplify Spline tool * reduces the number of points in the

spline. This function improves the performance in the model for complex spline
curves.

e Fit Spline. The Fit Spline tool . adds a spline based on the selected sketch entities
and edges.
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Tutorial: Spline 4-1

Show Spline Handles. The Show Spline Handles tool o) displays all handles of the
selected spline in the Graphic window. Use the spline handles to reshape the spline.

Show Inflection Points. The Show Inflection Points tool » displays all points where
the concavity of a selected spline changes.

Show Minimum Radius. The Show Minimum Radius tool @ displays the
measurement of the smallest radius in the selected spline.

Show Curvature Combs. The Show Curvature Combs tool R displays the scalable
curvature combs which visually enhances the curves of your selected spline.

@-N= % |

Create a 2D Spline sketch. D - Boie

1.

9.

E} I"t Equation Driven Curve
o B | FitSpine

Create a New U part. Use the default ANSI, IPS Part

template.

Right-click Right Plane from the FeatureManager.
This is your Sketch plane.

Click Sketch e from the Context toolbar.

Click the Spline ' Sketch tool. The spline icon is
displayed on the mouse pointer.

Create a seven point control spline as illustrated.
Do not select the origin. The Spline
PropertyManager is displayed.

Right-click End spline on the last control point.
Exit the Spline tool .

Click and drag the spline from left to right. Do not l_
select a control or handle. The spline moves without
changing its shape.

Click OK # from the Spline PropertyManager. -

10. Rebuild 8 the model. View the results.
11. Close the model.
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B Spline handles are displayed by default. To hide or

display spline handles, click the Show Spline Handles o)
tool from the Spline toolbar or click Tools > Spline Tools >
Show Spline Handles.

Tutorial: 2D Spline 4-2

Dimension a 2D Spline handle. E——
1. Open 2D Spline 4-2 from the SolidWorks HINE & OB
2010 folder.
2. Edit Sketchl.
Use the Smart Dimension tool to dimension the
spline handles. Display the handles.
3. Click the Spline in the Graphics window. The *
Spline PropertyManager is displayed. Locate = o
the pointer on the top handle. The rotate <
icon is displayed.
4. Click the top handle tip.
5. Rotate the handle upwards as illustrated to
create a Tangent Driving.
6. Right-click Smart Dimension € from the *
Context toolbar. = =
Create a Tangent Radial dimension.
7. Click the handle arrow tip.
8. Click the horizontal line.
9. Enter 40deg.
10. Set precision to none. 40°
11. Click OK % from the Dimension
PropertyManager.
12. Rebuild 8 the model. View the results. *
13. Close the model. | [ ]
¥ Fora Tangent Magnitude select the Tolerance/Precision A
arrow tip on the handle to add the dimension. 1507 [Mone v

.ol
A Mone % A
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Tutorial: 3D Spline 4-1

Create a 3D Spline part.

1. Create a New L part. Use the default ANSI Part template.
2. Click Insert > 3D Sketch from the Menu bar menu.

3. Click the Spline ™ Sketch tool.
4

. Click a location in the Graphics window to place the
first spline point. Each time you click a different
location, the space handle is displayed to help you
sketch on a different plane.

-

w1

Press the Tab key to change planes.

5. Click three additional locations as illustrated. The
Spline PropertyManager is displayed.

6. Right-click End Spline. |
",
7. Click Spline ™ from the Sketch toolbar to .
exit the sketch tool. ‘ L
8. Click OK # from the Spline / )
PropertyManager. First point
9. Exit the 3D Sketch. 3DSketchl1 is created
and is displayed in the FeatureManager. Last point
10. Close the sketch.
Tutorial: 3D Spline 4-2
Edit a 3D spline using the current elements.
1. Open 3D Spline 4-2 from the SolidWorks 2010
folder.
2. Edit 3DSketchl.
3. Click the Spline in the Graphics window. The / .

Spline PropertyManager is displayed.

Modify the Spline shape using the click and drag
method on a control point.

4. Click a spline control point and drag it upward.
The Point PropertyManager is displayed. You
modified the Spline shape.
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Modify the Spline shape using the X, Y and Z
coordinates method on a control point.

5. Click a spline point as illustrated. The Point
PropertyManager is displayed.

6. Set values for X, Y, and Z coordinates from the
Point PropertyManager. You modified the

Spline shape. L
Modity the Spline shape using the click and drag
method on a handle. Parameters A
7. Click a spline handle as illustrated. :x 0 E
v | 30,00 =
8. Drag the selected spline handle to control the ", [5.00 E
tangency vector by modifying the spline’s
degree of curvature at the spline point. The
Spline PropertyManager is displayed.
Reset the handle to the original location.
9. Click the Reset This Handle option. All values
relative to the selected handle return to their
original value. l. -
Move the spline.
10. Check the Proportional box.
Tangent Driving

11. Click and drag the spline from left to right. Do
not select a control point. As the spline is moved,
it retains its shape. Reset Al Handles

Reset This Handle

12. Click OK % from the Spline PropertyManager. Relax Splne
13. Exit the 3D Sketch. View the results. Pipa e
14. Close the model.

Tutorial: 3D Spline 4-3

Add new elements to a 3D Spline.

1. Open 3D Spline 4-3 from the SolidWorks 2010
folder.

2. Edit 3DSketchl.

Click the spline from the Graphics window. The ~
Spline PropertyManager is displayed.
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4. Click the Add Tangency Control 7 tool from
the Spline toolbar.

5. Drag to place the handle as illustrated.
6. Click a position for the handle.

7. Click OK % from the Spline
PropertyManager.

8. [Exit the 3D Sketch. View the results.
9. Close the model.

Spline on Surface Entity

The Spline on Surface entity tool provides the
ability to sketch splines on various surfaces.
Splines sketched on surfaces include standard
spline attributes, as well as the capabilities to add
and drag points along the surface and to generate a
preview that is automatically smoothed through the
points.

w1

“¥" All spline points are bounded to the surface on
which they are sketched.

Tutorial: Spline on Surface 4-1
Create a Closed Spline on Surface feature.

1. Open Spline on Surface 4-1 from the
SolidWorks 2010 folder.

2. Click the top left face as illustrated.
3. Click the Spline on Surface Sketch tool.

The spline ' icon is displayed on the mouse
pointer.

4. Create a five point closed spline as illustrated.

5. Click Spline on Surface to close the sketch
tool.

6. Click the Extruded Boss/Base Features tool.
The Boss-Extrude PropertyManager is displayed.
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7. Click the left vertical line as illustrated for
Direction 1.

8. Enter 10mm for Depth.

9. Click OK % from the Boss-Extrude
PropertyManager. Boss-Extrudel is
displayed. View the results in the Graphics
window.

10. Close the model.

Equation Driven Curve

The Equation Driven Curve M tool is a 2D sketch spline driven
by an equation. This Sketch entity provides the ability to create a
curve by specifying the equations that defines the curve.
Equations defining a curve specify Y as a function of X. You can
use any function that is supported in the Equations dialog box.

The Equation Driven Curve entity uses the Equation Driven
Curve PropertyManager. The PropertyManager provides the
following selections:

e Egquation Type. There are equation types available: Explicit
and Parametric.

e  Parameters. The Parameters box provides the following
options:

e Equation. Provides the ability to enter an equation as a
function of X. If you enter an equation that can’t be
resolved, the text color is displayed in red.

e Parameters. Provides the ability to enter the start and end
X value of the equation.

e Transform. Provides the ability to enter the translation of
X, Y and angle for the curve.

Tutorial: Equation Driven Curve 4-1

¥ R

Message -~

Enter an equation in terms of x
where the resulting v values are
calculated according to the start
walue x1 and the end walue 2.

b

Equation Type

(=) Explicit

() Parametric

Parameters A

Equation

Vx| |

Parameters

x @
x @

Create an Equation Driven Curve. G- m % T

1. Create a New [ part. Use the default ANSI, IPS Part - P“”Bl |
template. Right-click Front Plane from the @ nt B i S
FeatureManager. nate A | it spine

2. Click Sketch from the Context toolbar. The Sketch
toolbar is displayed.
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3. Click the Equation Driven Curve M Sketch tool. The Equation Driven Curve

PropertyManager is displayed.

Specify the equation that defines the sketch. Note: Y is a function
of X.

4. Enter: 3*x*sin(x) as illustrated in the Equation
box. n

5. Enter 0 for the start point as illustrated.

6. Enter 4*pi for the end point. Note: You can fix
the end points of the curve by applying the Fix 1
tool.

7. Click OK % from Equation Driven Curve
PropertyManager. View the created curve. Note
click the curve in the Graphics window to edit
the Parameters of the curve.

8. Click Exit Sketch. View the results. Close the
model.

w 1

R

Message 3

Enter an equation in terms of x
where the resulting v values are
calculated according to the start
walue 21 and the end walue x2.

by

Equation Type

(&) Explicit

O Paramnetric
Parameters a
Equation
¥ x| 3tctsiniz)
Parameters
b AR @
X0 @

“¥" Use regular mathematical notation and order of operations to write an equation. X1

and X2 are for the beginning and end of the curve. Use the transform options at the
bottom of the PropertyManager to move the entire curve in X, Y or rotation. To specify

X=f(Y) instead of Y = f(x), use a 90 degree transform.

Point Sketch Entity

The Point Sketch entity ;*% tool provides the ability to insert points
in your sketches and drawings. To modify the properties of a point,
select the point in an active sketch, and edit the properties in the
Point PropertyManager. The Point PropertyManager provides the
following selections:

e Existing Relations. The Existing Relations box provides the
following options:

e Relations. Displays the automatic relations inferenced
during sketching or created manually with the Add Relations
tool. The callout in the Graphics window is highlighted
when you select a relation in the dialog box. The
Information icon in the Existing Relations box displays the
sketch status of the selected sketch entity.

e Add Relations. Provides the ability to add relations to the
selected entity. Displays the relations which are possible for the
selected entity.
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e Parameters. Provides the ability to specify the appropriate
combination of parameters for your point only is the point is not
constrained by relations. The available parameters are:

e X Coordinate. Specifies the x coordinate of your point.

e Y Coordinate. Specifies the y coordinate of your point.

Centerline Sketch Entity __Insert Line

v R

Message ¥
The Centerline Sketch entity N tool provides the ability to use Orientation A
centerlines to create symmetrical sketch elements and revolved ® As sketched
features, or as construction geometry. The Centerline sketch entity = ;‘Z:L_Z;Tta'
uses the Insert Line PropertyManager. The Insert Line O Angee
PropertyManager provides the following selections: —— =
e Orientation. The Orientation box provides the following e eonsiUsian

OptiOIlSI [J1nfinite length

e As sketched. Sketch a line in any direction using the click
and drag method. Using the click-click method, the As
sketched option provides the ability to sketch a line in any
direction, and to continue sketching other lines in any
direction, until you double-click to end your process.

e Horizontal. Sketch a horizontal line until you release your
mouse pointer.

e Vertical. Sketch a vertical line until you release your mouse
pointer.

e Angle. Sketch a line at an angle until you release your
mouse pointer.

s
i

The angle is created relative to the horizontal.
e Options. The Options box provides two line types. They are:

e For construction. Selected by default. Converts the selected sketch entity to
construction geometry.

¢ Infinite length. Not selected by default. Creates a line of infinite length which
you can later trim in the design process.

w1

“¥* Use Construction geometry to assist in creating your sketch entities and geometry
that are ultimately incorporated into the part. Construction geometry is ignored when the
sketch is used to create a feature. Construction geometry uses the same line style as a
centerline.
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Text Sketch Entity
7 R
The Text Sketch & entity tool provides the ability to sketch text on | eurves A

the face of a part and extrude or cut the text. Text can be inserted on |4
any set of continuous curves or edges. This includes circles or
profiles which consist of lines, arcs or splines.

w1

b3

Text

“¥" Convert the sketch entities to construction geometry if the
curve is a sketch entity, or a set of sketch entities, and your sketch
text is in the same sketch as the curve.

The Text sketch entity uses the Sketch Text PropertyManager. The
Sketch Text PropertyManager provides the following selections:

: : : B|[7]®
e Curves. The Curves box provides the following options: -
e Select Edges, Curves Segment. Displays the selected : : _A_E [%]

curves, edges, sketches, or sketch segments.

i

e Text. The Text box provides the following options: o

e Text. Displays the entered text along the selected entity in e e
the Graphics window. If you do not select an entity, the text
is displayed horizontally starting at the origin.

Font...

e Bold Style. Bold the selected text.
e [talic Style. Italic the selected text.
¢ Rotate Style. Rotate the selected text.

e Left Alignment. Justify text to the left. Only available for
text along an edge, curve or sketch segment.

e Center Alignment. Justify text to the center. Only available
for text along an edge, curve or sketch segment.

e Right Alignment. Justify text to the right. Only available
for text along an edge, curve or sketch segment.

e Full Justify Alignment. Justify text. Only available for text
along an edge, curve or sketch segment.

e Flip. Provides the ability to flip the text.
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Flip Vertical direction and back. The Flip Vertical option is only available for
text along an edge, curve or sketch segment.

Flip Horizontal direction and back. The Flip Horizontal option is only available
for text along an edge, curve or sketch segment.

Width Factor. Provides the ability to widen each of your characters evenly by a
specified percentage. Not available when you select the Use document's font
option.

Spacing. Provides the ability to modify the spacing between each character by a
specified percentage. Not available when your text is fully justified or when you
select the Use document's font option.

Use document's font. Selected by default. Provides the ability to clear the initial
font and to choose another font by using the Font option button.

Font. Provides the ability to choose a font size and style from the Font dialog
box.

Tutorial: Text 4-1

Apply text on a curved part. Use the Sketch Text ~ - =l S
PropertyManager. f. : |.% Entities
1. '

Click Front Plane from the FeatureManager.

Click the Text A Sketch tool. The Sketch Text
PropertyManager is displayed.

Click inside the Text box.
Type SolidWorks. SolidWorks is displayed

horizontally in the Graphics window starting at the
origin, because you do not select an entity.

Click the front edge of Base Extrude. Edge<1> is
displayed in the Curves option box. The SolidWorks
text is displayed on the selected edge.

L 2 —h

- E¥n]

Open Text 4-1 from the SolidWorks 2010 folder. The [Dimyd \ Office Praducts |
Lens Cap is displayed in the Graphics window. N

Text
» Sketches bext, You can sketch text on
== faces, curves, edges, and sketch
- entities.

Uncheck the Use document font box.
Enter 250% in the Spacing box.

Click the Font Button. The Choose Font dialog box is
displayed.

10. Select Arial Black, Regular, Point 14.

Base Extrude
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11. Click OK from the Choose Font dialog box.

12. Click OK % from the Sketch Text PropertyManager. Sketch7 is created and is

displayed in the FeatureManager. Zoom in on the created text.

13. Close the model.

w1

“¥* If the curve is a sketch entity, or a set of sketch entities, and
the sketch text is in the same sketch as the curve, convert the
sketch entities to construction geometry.

Plane Sketch Entity

The Plane Sketch entity tool provides the ability for the user to
add Reference entities to a 3D sketch. Why? To facilitate
sketching and to add relations between sketch entities. Once you
add the plane, you need to activate it to display its properties and
to create a sketch. The Plane sketch entity uses the Sketch Plane
PropertyManager.

The Sketch Plane PropertyManager provides the following
selections:

o First Reference. Provides the ability to select Reference
entities from the FeatureManager or from the Graphics
window. Select the constraining relations to each reference.
The available relations selection is based on the selected
geometry.

e Reference Entities. Displays the selected sketch entity or
plane as the reference to position the 3D Sketch plane.

e Select a relation. Select a relation based on the selected
geometry.
w1
“¥" The available relations displayed under First, Second, and
Third References are based on existing geometry.

w1

“¥* The new planes in a 3D Sketch are sketch entities, just like
lines, arcs, splines, etc.
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e Second Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

e Reference Entities. Displays the selected sketch entity or plane as the reference
to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected geometry.

e Third Reference. Provides the ability to select Reference entities from the
FeatureManager or from the Graphics window. Select the constraining relations to
each reference. The available relations selection is based on the selected geometry.

e Reference Entities. Displays the selected sketch entity or
plane as the reference to position the 3D Sketch plane.

e Select a relation. Selects a relation based on the selected
geometry.

w 1

‘¥ With existing geometry, add a plane by referencing the entities
that are present. You can use any number of references required to
achieve the desired results.

Tutorial: Sketch Plane 4-1

« ¥ 42

Add a 3D Sketch plane. Add a plane using references. Select two
corner points of a 3D sketch. The corner points of the rectangle Message .
reference the position of the 3D sketch ff';iﬁr:ﬁ;;“jd(ge'i”i;es
plane or vertices) to define the
' sketch plang._‘l'hen sglect
1. Open Sketch Plane 4-1 from the e LGt
SolidWorks 2010 folder. ot Reference =
- »
2. Edit 3DSketchl from the ,? lEdlIk 2 1| I
FeatureManager. ) Sketch Flane 4-1
3. Click Tools > Sketch Entities > | E ii:i'z:mns E— A
Plane. The Sketch Plane 8= Material <not specified: -
PropertyManager is displayed. X Fronpate-—
X Top e Third Reference A
o %y might & B, L R
‘¥ The available relations are displayed 1. orig I
in the Sketch Plane PropertyManager 22 SR T

under the First, Second and Third
Reference. The relations are based on
existing geometry.
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4. Click the top front corner point of the rectangle as /L
illustrated. Point3 is displayed in the First Reference
box.

5. Click the bottom back corner point of the rectangle.
Point4 is displayed in the Second Reference box.

6. Click OK ¥ from the Sketch Plane V 18

PropertyManager.

7. Rebuild 8 the model. Plane2@3DSketchl is
created and is displayed in the Graphics
window.

&. Close the model.

Route Line Sketch Entity

The Route Line Sketch entity Ll tool provides the
ability to insert a Route line between faces, circular edges, straight |9 |ﬁ ||% «$ |
edges, or planar faces. The Route Line Sketch entity is active
when you: v X @

Items To Connect -

e Create an Explode Line Sketch.
e Edit an Explode Line Sketch.

e Select the Route Line tool in a 3D sketch.

The Exploded Line Sketch tool A7 is a 3D sketch added to an
Exploded View in an assembly. The explode lines indicate the
relationship between components in the assembly.

Options &
. . .E'? . [ JReverse
The Route Line Sketch entity uses the Route Line .
PropertyManager. The Route Line PropertyManager provides the P

following selections:

e [tems To Connect. The Items To Connect box provides the
following option:

e Reference entities. Displays the selected circular edges, faces, straight edges or
planar faces to connect with your created route line.

e Options. The Options box provides the following selections:

e Reverse. Reverses the direction of your route line. A preview arrow is displayed
in the direction of the route line.

e Alternate Path. Displays an alternate possible path for the route line.

e Along XYZ. Creates a path parallel to the X, Y and Z axis directions.
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w 1

-~

" Clear the Along XYZ option to use the shortest route.

Tutorial: Route Line 4-1

Create an Explode Line sketch using the Route Line Sketch
entity.

1.

Open the Route Line 4-1 assembly from the SolidWorks
2010 folder. The assembly is displayed in an Exploded
view.

Click the Explode Line Sketch A7 tool from the
Assembly toolbar. The Route Line PropertyManager is
displayed.

Click the inside face of Cut-Extrudel of Shaft-
Collar<1>. The direction arrow points towards the back.
If required, check the Reverse direction box. Face<1>
@Shaft-Collar-1 is displayed in the Items To Connect
box.

Click the inside face of the top hole of Cut-
Extrudel of the Flatbar<1> component.
Face<2>@pFlatbar-1 is displayed in the Items To
Connect box. The arrow points towards the right.

Click the inside face of Cut-Extrude5 of

Bill of
Materials

Exploded
Wiew

Explode
Line
Sketch

@

4

RodClevis<1>. Face<3>@AirCylinder-1is
displayed in the Items To Connect box. The
Arrow points towards the back.

Click the inside face of the second Cut-Extrude5
feature of RodClevis<1>. Face<4>@
AirCylinder-1 is displayed in the Items To
Connect box.

Click the inside face of the top hole of Cut-
Extrudel of the Flatbar<2> component.
Face<2>@pF]latbar-2 is displayed in the Items
To Connect box. The arrow points towards the
back.
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8. Click the inside face of Cut-Extrudel of SHAFT-
COLLAR<2>. The direction arrow points towards
the back. Face<1> @Shaft-Collar<2> is displayed in
the Items To Connect box.

9. Click OK # from the Route Line
PropertyManager. View
the created Route Line.

10. Click OK # from the

PropertyManager to :
return to the vE ¥
FeatureManager. Items To Gonnect A
Face= 1=@Shaft-Collar-1
11. Press the f key to fit the Face<2>@Flatbar-1
: Face< I=@AirCylinder- 1,F
mOdel to the Grap hics Face<4=@AirrCylinder-1/F
window. Face<2>@Flathar-2
12. Click Isometric view.
View the results.

13. Close the model.

w 1

“¥" You have the ability to

create a Bill of Materials

(BOM) in an assembly. The

BOM is displayed in the

Tables folder of the

FeatureManager. You no

longer need to create a drawing first. See the Assembly
section for additional information.

Tutorial: Route Line 4-2
Edit an Explode Line Sketch.
1. Open Route Line 4-2 from the SolidWorks 2010

folder. The Route Line 4-2 Assembly
FeatureManager is displayed.

= T2 Default<Default_Display State-

2. Click the ConfigurationManager tab. o EHTen =
3. Expand Default.  afimate explode
4. Right-click ExplViewl from the
ConfigurationManager. S V] |
5. Click Explode. ] o E——
£ B B Rdit Sketch
6. Expand ExplViewl. % 0 g |l
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Edit the Explode Line Sketch.

7. Right-click 3DExplodel from the ConfigurationManager.
8. Click Edit Sketch.

9. Display a Top view.

10. Click Centerline E from the Sketch
toolbar. The Insert Line PropertyManager

is displayed.
11. Click the endpoints of the Route Line as |
: / '.
illustrated. First oo ca
1rst point i
Create a new path. e —

12. Click a point to the right of the Route
Line endpoint and over the top of the
axle.

13. Click a point below the axle as
illustrated.

14. Click a point to the left of the axle over
the Flatbar.

15. Click a point below the Flatbar and a
point above the SHAFT-COLLAR.

16. Click a point below the Shaft-Collar.
Deselect the Sketch tool. Last point

17. Right-click Select in the Graphics
window.

18. Rebuild B the model. View the results.
19. Close the model.
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Belt/Chain Sketch Entity

This option provides the ability to create layout sketches for pulleys
or sprocket mechanisms. The Belt/Chain feature simulates a cable-
pulley mechanism. The Belt/Chain entity uses the Belt/Chain
PropertyManager.

w1
“¥" In the past, it was difficult using SolidWorks to effectively
model components such as cables, chains, and timing belts
due to their flexible motion. The shapes of these items could
change over time. This made it difficult to examine the way a
belt would interact with two or more pulleys, or a cable
system shifts a lever, or crank with a solid assembly model.

The Belt/Chain PropertyManager provides the following
selections:

e Belt Members. The Belt Members box provides the
following options:

e Pulley Components. Displays the selected arcs or
circles for the pulley components.

e Up arrow. Moves the selected pulley component
upwards in the displayed order.

e Down arrow. Moves the selected pulley component
downward in the displayed order.

e Flip belt side. Changes the side on which the belt is
located in the pulley system.

e Properties. The Properties box provides the ability to
define the following belt conditions. They are:

e Driving. Cleared by default. Provides the ability to
calculate the length of your belt. When checked, enter
a value if you do not want the system to calculate
your belt length. Based on the constraints, one or
more of the components may move to adjust for the
length of the belt.

e Use belt thickness. Specifies the thickness value of
the belt.
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e Engage belt. Selected by default. Disengages the belt mechanism.

w1

e Only circle entities in a block can be selected for a belt member.

Before you use the Belt/Chain sketch entity in an example, review Blocks in general and
the Block toolbar.

Blocks

Blocks are a grouping of single or multiple sketch entities. In SolidWorks, the origin of
the block is aligned to the orientation of the sketch entity. Previously, blocks inherited
their origin location from the Parent sketch. Additional enhancements to Blocks are:

e Modeling pulleys and chain sprockets.
e Modeling cam mechanisms.

Blocks are used in the Belt/Chain sketch entity. You can create blocks from a single or
multiple sketch entities.

Why should you use Blocks? Blocks enable you to:

e Create layout sketches using the minimum of dimensions and sketch relations.
e Freeze a subset of sketch entities in a sketch to control as a single entity.

e Manage complicated sketches.

e Edit all instances of a block simultaneously.

w1

“¥* You can also use blocks in drawings to conserve drawing items such as standard
label positions, notes, etc.

Blocks toolbar

The Blocks toolbar controls blocks in sketching. The Blocks
toolbar provides the following tools: —

g i Ar. IR RS

e Make Block. The Make Block [ tool provides the
ability to create a new block.

e Edit Block. The Edit Block &1 tool provides the ability to
add or remove sketch entities and to modify dimensions
and relations in your sketch.
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rE
Insert Block. The Insert Block tool provides the ability to add a new block to
your sketch or drawing. This option provides the ability to either create multiple
instances of existing blocks or to browse for existing blocks.

Add/Remove. The Add/Remove B tool provides the ability to add or remove sketch
entities to or from your block.

Rebuild. The Rebuild 8 tool provides the ability to update the parent sketches
affected by your block changes.

m
Saves Block. The Saves Block tool provides the ability to save the block to a file.
Adds an .sldblk extension.

Explode Block. The Explode Block K tool provides the ability to explode the
selected block.

-
Belt/Chain. The Belt/Chain & tool provides the ability to insert a belt.

w1

-

: Exploding a single instance of your block will only affect that instance of the block.

Tutorial: Block 4-1
Create a Block using the Blocks toolbar.

1.

Create a New U part in SolidWorks. Use the default L
ANSI Part template.
Click Top Plane from the FeatureManager. This is your
Sketch plane.
Sketch a closed sketch using sketch entities as
1llustrated. The sketch consists of five lines. l..
Click Make Block ] from the Block '™ Make Block______|
toolbar or click Tools > Blocks > v %
Mg s dpage o (SIS (MRS
’ (7 — - : Line4
Box-select the sketch entities from the ':"Erau"'{'{'Elerau't'} e il
Graphics window. The selected sketch = [A] Amnotations Linel
entities are is displayed in the Block i; atere <ok specied
Entities bOX. g Top Plane
> Right Plane
Click OK # from the Make Block L, origin Insertion Point A
PropertyManager. Note the location of |~ Esmkzt;hli_l Begen s e

the insertion point. Block1-1 is
displayed in the FeatureManager.

Rebuild B the model. Close the model.
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w 1

“¥* Create a block for a single or combination of multiple
sketch entities. Saving each block individually provides you

with extensive design flexibility.

Tutorial: Belt-chain 4-1

. ) ) ® 4 »
Use the Belt/Chain Sketch entity function. Create a pulley & fadl.JE 2 ]
sketch. W Belt-chain 4-1 {Default < <Default>_Di
fﬁl Sensors
1. Open Belt-chain 4-1 from the SolidWorks 2010 folder. +-[A] Annakations
View the three created blocks in the Belt-chain 3= Material <not specfied>

FeatureManager.
2. Edit Sketchl from the FeatureManager.

3. Click Tools > Sketch Entities > Belt/Chain. The
Belt/Chain PropertyManager is displayed.

Feature {Sketchl)

4. Select the three circles from left

to right. The select circles are Belt/Chain |
displayed in the Belt Members v %
dialog box. Message ¥
5. Check the Driving box. BeltMembers A [ ©
o Arc1/40MM_Circle- w—@
6. Enter 460mm for Belt Length. T || e
7. Check the Use belt thickness Igl ]
box. —
| 3 | Flip belt side W
8. Enter 20mm for belt thickness. : .
Properties A
9. Click OK % from the = Ligthi
Belt/Chain PropertyManager. briving
perty & 460mm : < @ L ®
10. Expand Sketchl. Beltl is created | use bett trickress
and is displayed in the bo.0omm -
FeatureManager. The calculated Engage belt .
belt length was larger than the N

belt length entered in the

PropertyManager. The system moved
the entities to correct for the entered %‘ paeRl-IED 2
460mm belt length‘ @ S elt-chain 4-1 (Defaulk< <Default:=_Di

11. Rebuild B the model. View the @ 5 IE: ii:s;t:mns

reSUltS. 3= Material <not specified:
Q Front Plane

12. Close the model. X TopPlane
6} Right Plane
I_, Crigin
=B (-} sketcht
Z0MM_Circle-1
40MM_Circle-1
BOMM_Circle-1

#7 Beltl {Length=460mm)
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Summary

In this chapter, you learned about the available tools to incorporate Design Intent into
your sketch, feature, part, assembly and drawing.

Sketching is the foundation of a model. You addressed 2D and 3D sketching and how to
recognize the various sketch states: Fully Defined, Over Defined, Under Defined, No
Solution Found and Invalid Solution Found along with identifying the correct reference
plane.

You reviewed the following Sketch Entities; Line, Corner Rectangle, Center Rectangle, 3
Point Corner Rectangle, 3 Point Center Rectangle, Parallelogram, Straight Slot,
Centerpoint Straight Slot, 3 Point Arc Slot, Centerpoint Arc Slot, Polygon, Circle,
Perimeter Circle, Centerpoint Arc, Tangent Arc, 3 Point Arc, Ellipse, Partial Ellipse,
Parabola, Spline, Spline on Surface, Equation Driven Curve, Point, Centerline, Text,
Plane, Route line and Belt/Chain.

You utilized and addressed the following toolbars; Block toolbar and Spline toolbar and
applied the Instant3D tool.

In Chapter 5, explore and address the Sketch tools, 2D to 2D toolbar, Geometric
Relations, Dimensions/Relations toolbar, the DimXpertManager and learn about
TolAnalyst.
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